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The Migratory Path of Office...

No matter what version of Word you’re currently in, a migration to a later
version of Office is somewhere in your present or your future. And when
your documents make the move, too — whether you leap from 97 to Office
XP, make a slight segue from 2000 into 2002, shuffle back to Word 6/95, or
intend the exciting maneuver into Office 2003 Editions — at best, you’ll
need a compass; at worst: a wholesale redesign.

The document’s intention is to be that compass. But before going anywhere,
wouldn’t you like to know: “What are other law firms are doing?”

“What are other law firms doing?”

What we currently know about Office upgrade strategies is:

m some Knowledge Partnership members — well on their way from Office
97 to Office XP — made a switch midstream to go to Office 2003,
instead;

= nearly half of our Knowledge Partnership membership plan to skip
Office XP and move into Office 2003 in the later part of 2004 or early
2005; and

m those currently in Office XP are holding at that level, at least for the time
being.

“What should we be doing?”

With this momentum afoot in the legal community, anticipate challenges
whether you’re moving up, or on the receiving end of any of the six active
versions of Word in the marketplace. Whatever your intentions, you’re likely
pondering:

m “What preparations should we be making for our move?” OR
m “We’re in 97 or 2000; what influence will 2002/2003 have in my
collaborative pursuits?”

Read on for answers to these — and many more! — questions!
“We’re moving. Where do we start?”

While every organization has its unique requirements, there are some
common steps to take, and a few some to avoid... The table below is by no
means a complete project plan, but should at least focus your research and
actions at the critical beginning stages:
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Goal

Learn the capabilities of Office XP/2003

How?

Office XP online

Office 2003 online

NEW! from Microsystems:
Office 2003 Research Map

Evaluate important fill-in forms to refactor them
into Web-based methodologies:

e PDF fill-in forms?
e HTML-based forms?
e transition to InfoPath 2003 or XML?

e connect such that they can leverage critical
data repositories?

Define requirements of each form:

e (data repositories leveraged?

e printable or on-line only?
Determine best technology leveraged

Decommission from current repository

Assess current work product against Firm
standards

DocXamine and DocXtools

Review your templates, precedents and masters:

e do they represent the quality standards of
your firm?

e (o they align to your firm’s “Best Practices”?

e do they align to your training program?

Request consulting or migration services

Refine training goals; customize document-based
review and deploy to desktop to reinforce
training initiatives

Consulting + DocXamine/DocXtools

Implement new software choices

consult with respective vendors
e infrastructure requirements

e desktop requirements

Define your deployment sequence

e consult with respective vendors

¢ schedule technology strategy session with all
vendors/players involved

e plan your project accordingly
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“We’re staying put: Will 2002/2003 have an influence on my
documents?”

Absolutely! You’ll want to know more than the document ‘gotchas’, because
knowing the capabilities of the latest version of Word enables you to speak
intelligently to your clients and collaborators, and to leverage its broadened
feature set.

So, how much do you already know — and how much do you need to know?
Assess your knowledge using Microsystems’ interactive document impact
assessment quiz. Its lessons include:

m  The best format to use when collaborating with track changes
m  Which filter best assists in a troubled-document scenario
m  What features ‘get lost” on the way back to a lesser version of Word

What are the document ‘gotchas’?

What special brand of ‘gotchas’ will your migration path attract? The table
below illustrates a few of the issues most common in each maneuver:

Trail Issues

Legacy Heading Numbering

Compatibility options

Legacy Cross References

Table borders

Legacy symbols/fonts
{SEQ}{AUTONUM} field code-numbering

6/95 = 97 or later

Compatibility options
97 - 2000 “Fractured Footnotes”
Sluggish Table performance

Compatibility options

“Fractured Footnotes”

Table layout

Table borders

Linked “Char” or Word-generated “Style + "styles
File size increases > “Embed Linguistic Data”
File size increases > “Embed Smart Tags”

Hidden paragraph to Style Separator

“Disable Features Not Introduced After”

Track Changes: ‘markup balloons’

97 - 2002
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Trail Issues

Compatibility options

“Fractured Footnotes”

Table layout

Table borders

Linked “Char” or Word-generated “Style + "styles
File Size increases > “Embed Linguistic Data”
File Size increases > “Embed Smart Tags”

Hidden paragraph to Style Separator

“Disable Features Not Introduced After”

Inability to File | Save As | WordPerfect

97 - 2003

The good news is these ‘gotchas’ are easily reconciled once inside Word
2002 or Word 2003. If, however, you’d like to clean out some of your
previous legacy, or alter your document’s design decisions, read on for some
added directionals...

Migrating from Word 97 to Word 2002/2003 -- some directionals...

Binary formats — the same!

You’ll be pleased to know that the binary format of a Word 97 document is
the same as the binary file format for Word 2002 or 2003. This means you’re
less likely to require a wholesale conversion project. However, there are
issues you’ll want to be aware of before, during, and after you make your
move into 2002 or 2003. Before you move ahead, look both backwards and
forward:

Looking back: How’d you get to Word 977

If your document population assumed a Word 97 binary format from another
application — perhaps WordPerfect, perhaps Word 6/95 — how’d you get
there? If you FileOpened from either of these versions, and your documents
contain numbering, or legacy styles, abandoned formatting methods, or
insertion of graphics, you may need some type of intervention. We find the
most troublesome Word 2002 and 2003 documents are Word 97 documents
with a checkered past. If your content moved into Word 97 the right way,
however, your documents are 2002/2003-ready!

Look ahead: Do you have any redesign initiatives?

Most organizations moving from Word 97 into Word 2002 or 2003 intend to
refactor something in their move, whether that be:

m hidden paragraphs into the new style separator

m style consolidation

m an interface-lift (e.g., fewer toolbars, simpler menu choices, cleaner and
more accessible features)

m adding metadata for an upcoming XML initiative;

m forging a unified document environment and branding due to a recent
merger;
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= “Know-how” or precedent document clean-up and reformatting; or
m introduction or acceleration of Smart Document, InfoPath or PDF
adopted for more automated document assembly and workflow.

In these cases, the migration from Word 97 to Word 2002 or 2003 is less of a
conversion, and more of a “mass makeover” of the authoring environment as
you currently know it.

If you find yourself in this mode, give our Solutions Center a call
(630-598-1100). They’ll put you in touch with the right folks in our
Consulting team to assist you in your planning, preparation and project
definition.
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Application-based considerations

A bad move:

Special Alert:
Whatever you do,
don’t Disable™...

We’ve worked with several Knowledge Partnership members as they’ve
made the move from Office 97 to Office XP — just as we’re working now
with several clients planning their moves into Office 2003. The issues noted
below have been experienced by several of them — and us! — and we pass
along their findings and fixes for your benefit.

“Disable Features introduced after Word 97”

Whatever you do: resist the temptation to force the “Disable features
introduced after...” setting (Tools > Options > Save> “Disable
Features Introduced After Word 97”) to ‘on’. While it seems like a
good idea to maintain compatibility between your internal staff,
during the period of time it takes to get through your migration, or it
would provide external benefits to the Word 97 clients you may
work with on an on-going basis, you’ll regret having to retract the
setting down the road...

Word 2003: Tools | Options | Save dialogue

I : s 1
| s 7| d |
|

Security apeling & Grammar Track Changes

User Information Compatibility File Locations

Wiew General Edit Print Save

Save options
[lialways create backup copy: [ Prompt For document properties

[ Allow Fast saves [ Prompt to save Mormal template
[ allow background saves [1 sawe data only for forms
[ Embed TrueType fonts Embed linguistic data

[ Make local copy of files stored on network o removable drives
|:| Save AutoRecover info every: - minukes
Embed smart tags

D Save smark kags as XML properties in Web pages

Default Format

Sawe Word files as: ‘ord Document {*.doch

[] bisable Features introduced after:
Don’t
“Disable”!

Under the hood, the feature has two parts — one part application-based, one
document-based. Unfortunately, a VBA bug in Word 2002/2003 “disables’
your ability to fully turn off this functionality.

[ O, ]| Cancel ]

For more details, check out the news postings on Google Groups which refer
to Microsoft trouble ticket number: SRX-030529603033.
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Features Lost in the Shuffle Back to Lesser Word Versions

As we’ve mentioned, Word 2002 and 2003 maintain the same binary format
as Word 97. This means your Word 97 clients can open documents you’ve
created and saved with Word 2002 or 2003. However, know that when
features introduced after Word 97 are applied in a document using Word
2002 or 2003, then opened in Word 97 or Word 2000, these features may not
maintain the same formatting seen in the later versions.

These features are:

use of 24 bit color

use of nested tables

HTML cell spacing and padding

table-wrapping

underline colors

decorative underlines

gutter positioning on top

text-wrapping line breaks (graphics)

floating text-wrapping with graphics in tables

graphics positioning (middle or bottom aligned objects, relative to line or
character)

digital signatures

Asian text formatting features

HTML formatting features (frames, linked style sheets, DIV borders)
Smart tags

Security-minded in 2003

Because Office 97 had no security, and Office 2000 had very little security,
the enhanced security settings of Office XP — and the elevated settings (e.g.,
“Very High”) in Office 2003 Editions — may force you to rethink how you
install add-ins, global templates and other macros.

Office 2003 users: you’ll want to check out the addition of “Very High”
macro security which declares that only macros installed in trusted locations
are permitted to run (see Figure 1 below, and Macro Security Levels in
Office 2003 in the Office 2003 Resource Kit), and the new and Information
Rights Management feature which restricts access, editing and/or formatting
permissions for Office Profession Edition 2003 applications. Trustworthy
computing begins to unfold...
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SETIIE ._Jd

Security Lewel | Trusted Publishers | Prior Trusted Sources

(&) ery High, Only macros installed in trusted lacations will be allowed
o run, All other signed and unsigned macros are disabled.

) High. only signed macros From trusted sources will be allowed to
run, Unsigned macras are aukomatically disabled,

{3 Medium. You can choose whether of not ko run potentially unsafe
macros,

) Low {not recommended), You are not protected From potentially
unsafe macros, Use this setting only if wou have virus scanning
software installed, or vou have checked the safety of all documents
wou Opern,

[ Ok ] [ Cancel

Figure 1 - Macro Security in Word 2003
You won’t be able to File | Save As WordPerfect any longer!

Although most of us finished our WordPerfect conversions awhile back, you
may have occasional needs to produce a WordPerfect edition of your work.
With the release of Office 2003 Editions, a new converter pack retires the
previous converter packs, and no longer includes an export method to
WordPerfect. The import or File | Open side remains for both WordPerfect
5.x and 6.x, but you can no longer File | Save As WordPerfect 5.x.

Should you need to go back to WordPerfect, we’d recommend using the File
| Save As | “Word 97-2003, & 6/95 RTF” filter for this purpose.

Gratuitous & Linked Styles in 2002/2003: Word makes them up!

If you’ve seen your documents spontaneously populate with random
character styles whose names end in the word “Char”, then you’ve stumbled
upon Word’s new “linked styles” feature! This feature was introduced in
2002, and remains in 2003. You’ll experience issues with this feature as you
attempt to unify your templates, or automate style operations as styles can
become double- and triple-linked without realizing it! To find and fix these
styles, we’ve provided the following tips: both using native Word and
Microsystems DocXstyles/DocXtools. We’ll also tell you one way we know
of to avoid their creation.

(Note: If you know of additional ways they are created, we’d be interested in
know — send us email at help@microsystems.com and we’ll include your
insights in our next Knowledge Base update!)
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To “spy” them in Word 2002/2003:

1. While pressing the Shift key, drop-down the “Styles” list on the

Formatting toolbar.

2. When present in a Word 2002/2003 document, they’ll be
revealed in this special view of the Styles list (see .Figure 2

below).
Ay UUS G b freis, dus - iz uie Wy
File Edt Wiew Insert Formab  Tools  Table RoboPDF  Window  Help  Adobe PDF Adobe PDF
AN=NE REREITE R A Y Fs A ENEN=N= sl
rﬂ—HTimesNewRoman -2 ~-|B I U |§§E§¢§v|£ 1= iE
i Clear Formatting e=l
] =
CHAR CHAR a
- 1L 17117111 i=
_ D tradi =
Article I Article / Section i=
Balloon Text 1 N
N Block Text 1 (
- Body Text 2 1
- .4
™ ||| Body Text 3 1
Body Test Char Char, Body Text Charl Char Char Body Text Char ... a _|
Body Text Continued 1
~ Body Text First Indent 1d

Figure 2 — “Char” styles ‘revealed’

NOTE: If they’re present in the document, they’ll immediately be exposed

when opening the document using Word 2000 or Word 97.

To introduce a “Char” style in your document (for

educational purposes only!):

1. Apply the “Body Text” paragraph style to a paragraph of text.

2. Select the first few words of the paragraph.

3. Once again (where first?), Apply “Heading 1”, this time to the

selected characters.
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Figure 3 - Heading 1 “Char” style created

4. Hold down the Shift key, then drop down the Styles list in the
Formatting toolbar -- notice the new addition, a character style
named “Heading 1 Char™.

NOTE: This is a new behavior in Word 2002/2003; when invoking this
technique in Word 2000 or Word 97, only the character formatting associated
to the Heading 1 style would be directly applied to the selected text.

To “fix” the “Char” style problem:

Because, by definition, “Char” styles are linked to another style, they can be
troublesome to eliminate: when you delete them, they’ll delete all applied
formatting too...If they?? are few of them in the document, you might
consider renaming them to more appropriate names, however realize: they’ll
remain ‘linked’ to their governing paragraph style.

In some circumstances we’ve seen these styles become overly populous, or
‘chain-linked’, such that MANY paragraph styles are affected. One trick our
Solutions Center discovered was to:

open the document in Word 2000 where linked styles are not ‘supported’
create a new character style or styles to have desired character formats
replace all “Char” styles with your new character styles

delete all the offensive “Char” styles, and Save

then reopen in Word 2002/2003 to verify the result

To curtail the creation of “Char” styles in your document:

To curtail the creation of “Char” styles in your document, never select
individual characters when applying paragraph styles; apply paragraph styles
at an insertion point OR make sure that at least ONE paragraph marker is
contained in your text selection.

NOTE: We are unaware of any means by which this functionality can be
turned off in Word 2002 or 2003.

Migratory indents in 2002/2003: The ListTemplate strikes again...

Check out Microsoft Knowledge Base article 812637 — seems the number
position on some customized outline schemes “collapses’ upon opening a
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Word 97 file in Word 2002. If you’re experiencing the problem and are in
Word 2000 or 2002, don’t worry — Microsoft has a hotfix available. As for
Word 2003, we’re still awaiting details...

Nullified numbers in 2002: “Page 0”

We’ve seen this one at two clients, both of whom realized the issue when
using previously-designed document templates which contained tables and/or
text frames in the header or footer. The issue’s symptom is that page
numbers unexpectedly begin numbering at “0”, and no amount of altering the
“Start At” value corrects the issue (see Figure 4 below).

ANY FIRM-LLP
A0 FIHERE 115 S iz
123 L4l STETI T [w] =00

Chise L eq
Figure 4 - “Page 0” issue in Word 2002

Should you experience this issue in 2002, we successfully worked around the
issue by converting the Text Box into a Frame; in another situation, the client
installed the hotfix noted in Microsoft Knowledge Base article 292158.
NOTE: This issue is resolved in Word 2003.

Endlessly repaginating: “My VBA code didn’t do this before!”

We’ve found Word 2002 has many sensitivities not experienced in previous
versions of Word, especially when querying the paragraph object for
information such as “Is the paragraph in a table?” The document will
paginate excessively, and your routines will have significantly diminished
performance. We eliminated all uses of

“Selection. Information(wdWithinTable)” in our code, and
recommend you do, too!

Application-based treasures
Stability

Office XP and 2003 Edition bring greater stability to the Word authoring
environment. That, coupled with “Open and Repair” (see below), mean
you’ll spend less time wondering where your document went and why!

ListTemplate tallies

Word 2002 and 2003 has such curative properties where list template build-
up is concerned! If you’re finding an excessive number of list templates in
your Word 97 or Word 2000 document (e.g.,
?ActiveDocument.ListTemplates.countin VBA’s Immediate
Window), you’ll love that Word 2002 clears them out. Simply File Open in
Word 2002, File Save As in Word 2002, then reopen in the previous version
of Word — instant excising of list templates!
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They’ll love multiple-select.

Your users will love the ability to multiply select non-contiguous text blocks
— and the ability to highlight all occurrences of a string when using Edit >
Find. We love it too!

You'll love “Open-and-Repair”!

This buried treasure (File > (drop-down) > Open and Repair) will be one of
the most-often used features in your Word 2002/2003 shop, just as it is at
Microsystems. We use it to cure files which previously would not open, as
well as on files which opened, but seemed to behave badly after editing for
awhile. Take care, though: often the ‘repair’ removes content and/or
formatting in an effort to cure the document’siills... To use Open and Repair:

1. File | Open, then select — but don’t open — the desired file.

]
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2. Pull-down the menu at the Open button, and choose “Open and
Repair”.

3. Microsoft Word will repair all known issues, and list them in a
confirming dialogue. Click OK to continue editing the repaired
file.

Turn a template into a document...

The macro virus of Word 6/95 whereby templates — then, the only Word file
type that carried macros — masqueraded as documents, brought us an
inability to File | Save As a template into a document. You’ll be happy to
know that Word 2002 and Word 2003 gives us this capability! Serves as both
a fast way to exorcise AutoText entries from a template, or a nice way to turn
an inappropriately-saved template back into the document it should have
been all along.
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Document-based considerations
“What about our templates?”

We strongly recommend reviewing each template to ensure you still need it
— besides: when was the last time you revisited your templates? You may
be able to eliminate templates, but for those you need to keep around, make
sure you ‘remake’ them. There are many curative properties to reconciling
ListTemplates and stabilizing numbering in Word 2002/2003, from which
your templates will benefit. Steps toward a template makeover are:

In Word 2002:

1. Using Word 2002, File | New to create a new blank template.

2. Use Insert | File, bringing your Word 97 template into your new
template.

3. Make any necessary modifications, and File | Save your updated
Word 2002-edition template.

In Word 2003:
1. Using Word 2003, File > Open your templates.

2. Then, to eliminate the binary build-up in your template files, File
| Save As XML, and File | Close.

3. Next, File | Open, then File | Save As “template”.

4. Make any necessary modifications, and File | Save your updated
Word 2003-edition template!

Don’t forget your AutoText!

As part of your template makeover, don’t forget to revise your Auto Text
entries -- they need to represent your improved or altered design intentions!

Compatibility Options

Your legacy work product, when opened in Word 2002 or 2003, will
maintain compatibility with its original authoring app. As you move
documents up, ensure Compatibility Options are advanced from “Word 97”
to “Word 2002” or “Word 2003”. If you don’t change these options, expect
to see the following symptoms:

m Fractured footnotes
m  Lost formatting
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What Microsystems offerings will help me make the move?

DocXtools

Microsystems suite of products, and its Solutions Center, training and
consulting services are Word 2002- and 2003-aware. Some options you may
want to explore include:

DocXtools assesses, cleans, and formats documents. Indispensable for those
who want to easily produce quality Word documents.

DocXtools can be configured to launch on open, or can be invoked on
demand — and we give you the ability to design or define workflow
messages delivered right to the users desktop!

Some examples of how DocXtools has been implemented into client sites:

m  Update to XP or 2003 Button

We have clients whom created an Update to XP/2003 button for their
toolbar. Then, at the users’ discretion, they can open and update the
document to desired XP/2003 settings.

= Analyze on Open

DocXtools can be setup to analyze a document on open. If the
Compatibility Options are set to Custom or Word 97, we can
automatically make this change before the user starts working on the
document.

m  Update Document with New Styles

When migrating from Word 97 to Word 2002/2003, many clients have
decided to change their style names. DocXtools Apply features can be
used to apply new styles to appropriate paragraphs.

To isolate “Char” styles using the DocXtools or
DocXstyles “Style Manager” feature:

1. Launch Style Manager.

2. Drop-down the “Find” button, choose “Advanced Find By
Format.”

3. Choose Properties > Style > Properties > Name, pull down
Condition and choose Contains.

4. Type a value of Char, followed by a space, and click on Add to
List.

5. Find Styles. The offending styles are listed.

Special Note to DocXtools users:

DocXtools default Discovery rules seeks out “Char” styles by default.
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DocXamine

DocXamine performs automated document analysis, accelerating your ability

to:

m analyze a repository of templates and masters against a firm’s best

practices

m conduct document-based reviews of student results, either during or after

training classes

m  pre-assess work product intended for reuse, before trouble strikes!

DocXamine’s default shipping rule set includes test for many of the
document “‘gotchas’ introduced by Word 2002 or 2003 (such as compatibility
options, linked “Char” or Word-generated styles). Imagine an automated
method for uncovering the templates or masters in which these conditions
exist before they infest your overall document repository? A sample report is

shown in Figure 5 below.

Documents with score of 0:
Exam Date: 12H 042003 3:AG25PM

doc(amine
Document - Rule Exception
Collection: Test Collection
Documents in collection: 1

Document
Weh Agreement.doc

Path
CiKPCoursevwaretAdmini
_Course\StudentPracticel

Am | a Bad Document?
Applied style inappropriate for location
Cell spacing non-standard
Compatibility seftings don't match
Diouble-byte characters found
Empty paragraphs found
Headers or fodters overlap margin seftings
Leading tabs or spaces present
Most content directly-farmatted
Multiple languages present
Mumbering isincorrect
Redline remnants found
SEQ codes found
Straight guotes in use
Substitute or embedded fonts suspecied
Tahles extend heyond page margins
Useless section breaks found
WordPerfect conversion detected
Score: 2275 out of 10000

Figure 5 - Sample DocXamine report
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DocXchange

DocXchange converts WordPerfect or legacy Word documents into the latest
version of Word or PDF. Satisfactory results guaranteed.

DocXchange has been updated to be fully Word 2002- and 2003-aware.
Among the features added are the ability to alter compatibility options,
automate Word 2002 or 2003 optimally (e.g., minimizing repagination
episodes), and be sensitive to the presence of new style types (e.g., list styles
and table styles). Should you require an update, feel free to contact us at
help@microsystems.com.
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